
Chapter 1: Operating System and Graphical  
User Interface: Role and Functions

A.	 Fill in the blanks.
	 1.	 A set of instructions given to the computer is called a ___________.
	 2.	 Computer works with an interaction of ___________ and ___________.
	 3.	 We can broadly classify software into two types: ______________ and __________________.
	 4.	 ______________________ uses multiple central processors to serve multiple real-time 

applications and multiple users.
	 5.	 ____________ is the most popular GUI operating system.

B.	 State whether the following statements are True or False. 
	 1.	 Computer works with an interaction of hardware and software.
	 2.	 Software refers to any physical component of a computer.
	 3.	 Hardware refers to the programs, which are required to operate the computer.
	 4.	 An operating system manages the sharing of internal memory among various applications.
	 5.	 A single-tasking operating system allows to perform multiple tasks using one CPU.

C.	 Match the columns.
			   Column A		  Column B
	 1.	 Single-User Operating System	 (a)	 Application generators
	 2.	 Multi-User Operating System	 (b)	 OS/2
	 3.	 Multitasking Operating System	 (c)	 Xenix
	 4.	 Application Software	 (d)	 Linux
	 5.	 System Development Software	 (e)	 Adobe PageMaker

D.	 Explain the following.
	 1.	 System Software
	 2.	 Application Software
	 3.	 Operating System
	 4.	 Multitasking Operating System
	 5.	 Real-Time Operating System

E.	 Answer the following questions.
	 1.	 What is the need for an Operating System?
	 2.	 What are the different types of user interface?
	 3.	 What are the advantages of GUI over CUI?
	 4.	 Discuss the disadvantages of GUI over CUI.
	 5.	 What are the features of an operating system?

Worksheets



Answers to Worksheet

A.	 1.	 program
	 2.	 hardware, software
	 3.	 system software, application software
	 4.	 Distributed operating system
	 5.	 Windows
B.	 1.	 True	 2.	 False	 3.	 False
	 4.	 True	 5.	 False
C.	 1.	 (b)	 2.	 (c)	 3.	 (d)
	 4.	 (e)	 5.	 (a)
D.	 1.	 System software is required to control the working of hardware and aid in effective execution 

of a general user’s applications such as fi le editing, storage management, resource accounting, 
I/O management and database management. Some examples of system software are DOS, 
Windows and Linux. System software can be further categorised into two types: system 
management software (operating systems) and system development software (language 
translators, application generators and CASE tools). 

	 2.	 Application software consists of programs that are required to perform specific types of work 
for end users on the computer. They are required for general and special purpose applications 
such as database management, word processing and accounting. Microsoft Word (MS Word), 
Microsoft Excel (MS Excel), Adobe PageMaker and Tally are some examples of application 
software. Application software can be further classified into following two types: general 
purpose application software and customised application software.

	 3.	 The hardware of a computer system cannot function on its own. When a computer is switched 
on, it needs to be instructed by the user on what to do next. A computer needs instructions for 
every operation and we know that a computer understands only machine language. Hence, 
an interface between the user and computer, through which the computer can be instructed 
to perform the required operation, is required. This interface is called an operating system 
software, which acts as a link between the user and computer, and provides an environment 
to the users. DOS, Windows, Unix and Linux are some common operating systems.

	 4.	 The act of performing multiple tasks at a time is called multitasking. A multitasking operating 
system allows to perform multiple tasks using one CPU. It performs the tasks so quickly that 
it gives the appearance of executing all programs at the same time. Unix, Linux and Windows 
are some examples of multitasking operating systems.

	 5.	 A real-time operating system is a system in which the time interval required to process and 
respond to input is so small that it controls the environment. It is used when there are rigid 
time requirements on the operation of a processor or the flow of data. Such operating systems 
must have well-defined and fixed time constraints to prevent system failure. Medical imaging 
systems, industrial control systems, weapon systems and air traffic control systems are some 
examples of real-time operating systems.

E.	 1.	 Hardware is of no use unless it is guided about the tasks it needs to perform. An operating 
system knows what to do, how to do and when to do it. We need an operating system for the 
following purposes.



		  •	 It helps to run multiple applications on a single system at the same time, thus saving our 
time.

		  •	 It helps with the allocation of resources to different applications. 
		  •	 It can share a single resource or hardware among different applications, saving hardware 

resources.
		  •	 It helps in sharing a single system with multiple users.
	 2.	 There are two types of user interface. 
		  •	 Character User Interface (CUI): Character user interface is a command-based interface 

where the user needs to type commands to interact with the computer system. The 
beginners are not comfortable with such interface as they need to memorise the 
commands.

		  •	 Graphical User Interface (GUI): Graphical user interface is a graphics-based interface where 
devices like keyboard and mouse are used to interact with the system. It allows the use of 
icons to interact with devices rather than using only text. It does not require the user to 
memorise the commands. Windows is the most popular GUI operating system.

	 3.	 Following are the advantages of Graphical User Interface (GUI) over Character User Interface 
(CUI).

Graphical User Interface (GUI) Character User Interface (CUI)

GUI interface is more user-friendly and 
attractive.

CUI is not as attractive and user-friendly as GUI.

It uses icons to interact with the system. It uses commands to interact with the system.

The user does not require to learn the 
complicated commands.

The user requires to learn the commands to 
interact with the system.

It offers the user to view multiple programs 
at the same time.

It does not offer the user to view multiple 
programs at once on one screen.

It supports the use of both keyboard and 
mouse to navigate through a system. It 
supports only the use of keyboard.

It supports only the use of keyboard.

It offers the user to get the immediate 
feedback of the action that is being 
performed.

It does not offer immediate feedback of the 
action that is being performed. Rather one or 
more additional commands are executed to 
-confirm the action that is performed.

	 4.	 Following are the disadvantages of Graphical User Interface (GUI) over Character User Interface 
(CUI).

Graphical User Interface (GUI) Graphical User Interface (GUI)

More RAM is required. Less RAM is required.

Development of presentable interface is a 
time-consuming process.

CUI development is command-based, so it is 
less time consuming.

It is more expensive as the user needs to 
pay the license fee.

It is less expensive.

It is slower as compared to CUI. It is faster because commands perform the task 
quickly.



	 5.	 Most of the operating systems have certain common features and functions. They are as 
follows.

		  Resource Management: An operating system manages all the resources that are attached to 
the system. Memory, processor, input and output devices that are attached to a computer are 
called the resources of a computer system. The operating system decides which operation is 
to be performed at what time by the CPU and in what time the memory will be used by which 
programs. Windows 95 was the first operating system to support Internet connection sharing. 

		  Memory Management: An operating system manages the sharing of internal memory among 
various applications. It is responsible for efficient utilisation of memory like cache and RAM 
within the system. It also takes care of the memory of all the processes and is responsible for 
de-allocation of memory from the process.

		  Storage Management: An operating system decides how the data or files will be stored in the 
computer and how the files will be accessed by the users.

		  File Management: An operating system allows the users to create files and directories, and 
keeps a track of information regarding processes like creation, deletion, transfer and copy in 
an organised manner.

		  Security: An operating system has inbuilt security modules that protect the resources and 
information stored on a computer system from unauthorised access.



Chapter 2 : Spreadsheet—Formulas and Functions

A.	 Fill in the blanks.
	 1.	 __________ is used to perform calculations either using a formula or a function.
	 2.	 Excel operators perform actions on ______________, text or ______________.
	 3.	 The ______________ are used to compare two values. They give the result in true or false.
	 4.	 A _________ is a group of continuous cells which form the shape of a rectangle.
	 5.	 The cell address that we use in the formula is called the ________________.

B.	 State whether the following statements are True or False. 
	 1.	 The arithmetic operators perform calculations with alphabetic values only.
	 2.	 You can only perform addition on String data type.
	 3.	 A range can be as small as single cell or as big as an entire worksheet.
	 4.	 Each cell has an address denoted by the column numbers and row letters.
	 5.	 When a formula in a cell refers to its own cell value, it is called range reference.

C.	 Choose the correct answer.
	 1.	 In which of the following cases does the error #N/A appear?
		  (a)	 Formula contains an invalid operation
		  (b)	 Data is not available
		  (c)	 Text in a formula not recognised
		  (d)	 Division by zero is being performed
	 2.	 In which of the following cases does the error #VALUE! appear?
		  (a)	 Division by zero is being performed
		  (b)	 Data is not available
		  (c)	 Formula contains an invalid operation
		  (d)	 Text in a formula not recognised
	 3.	 In which of the following cases does the error #DIV/0! appear?
		  (a)	 Formula contains an invalid operation
		  (b)	 Data is not available
		  (c)	 Column is not enough to display the number
		  (d)	 Division by zero is being performed
	 4.	 In which of the following cases does the error #### appear?
		  (a)	 Column is not enough to display the number
		  (b)	 Text in a formula not recognised
		  (c)	 Data is not available
		  (d)	 Division by zero is being performed
	 5.	 In which of the following cases does the error #NAME? appear?
		  (a)	 Formula contains an invalid operation
		  (b)	 Data is not available
		  (c)	 Text in a formula not recognised
		  (d)	 Division by zero is being performed



D.	 Explain the following.
	 1.	 Relative Reference
	 2.	 Absolute Reference
	 3.	 Mixed Reference
	 4.	 AutoSum

E.	 Answer the following questions.
	 1.	 What does the data in a formula consists of?
	 2.	 Can you reference one worksheet to another in Excel? If yes, write the steps to do so.
	 3.	 Discuss some common error results in Excel.
	 4.	 Write the rules that should be followed while using a function.
	 5.	 Write the steps to rename a worksheet.



Answers to Worksheet

A.	 1.	 Excel 2016
	 2.	 numeric values, cell references
	 3.	 relational operators
	 4.	 range
	 5.	 cell reference
B.	 1.	 False	 2.	 True	 3.	 True
	 4.	 False	 5.	 False
C.	 1.	 (b)	 2.	 (c)	 3.	 (d)
	 4.	 (a)	 5.	 (c)
D.	 1.	 In relative reference, the formula in the copied cell changes according to the change in the 

position of the cell pointer. For example, if the formula in A3 is = A1 + A2 and you copy the 
same formula to B3, then Excel automatically changes the cell address in the formula.

	 2.	 An absolute reference is specified using the $ sign along with the column and row number 
of the cell. For example, $A$1 + $A$2 is an absolute reference. The purpose of $ is to fix the 
reference to a specific location. This type of referencing is used when we do not want to 
change the address of the cell while copying the formula to another cell.

	 3.	 Mixed reference is a combination of relative reference and absolute reference. In this type, 
either the row or column has to remain fixed. $B4 is an example of mixed reference.

	 4.	 The AutoSum option is used to carry out different functions like Average, Count, Max and Min. 
To get AutoSum, click on the AutoSum button in the ‘Function Library’ group of the ‘Formulas’ 
tab. AutoSum is also present in the ‘Editing’ group of the ‘Home’ tab.

E.	 1.	 The data in a formula consists of the following.
		  •	 Values: String or numeric
		  •	 Cell address: A1, B4 and so on
		  •	 Functions: MAX, MIN, SUM and more
		  •	 Operators: +, –, *, /, and more
		  •	 Parenthesis: ( )
		  Example: 

				  

= A2 + B3 * 3 – Sum (B4 : B7)

Range

Operators
Parenthesis

Function

Cell Address

	 2.	 Yes, Excel provides the facility to use cell reference of one worksheet in another worksheet.
		  Follow these steps to do so.



		  •	 Enter the data in Sheet 1 as shown. We will be using the cell address ‘D6’ of Sheet 1 in Sheet 
2.

		  •	 Enter the data in Sheet 2 as shown. Select an empty cell in Sheet 2 and type = sheet 1! D6. 
Press the Enter key and the value of D6 from Sheet 1 will be displayed in the desired cell.

	 3.	 You might get errors while performing calculations in Excel as the formulae entered can have 
some problems. Some of the common error results are discussed here.

		  •	 #N/A: Data is not available.
		  •	 #VALUE!: The formula contains an invalid operation.
		  •	 #DIV/0!: Division by zero is being performed.
		  •	 ####: The column is not enough to display the number.
		  •	 #NAME?: Excel does not recognise the text in a formula.
	 4.	 Following rules should be followed while using a function.
		  •	 A function must begin with an equal to (=) sign.
		  •	 A function name must be valid. Sum and Average are some function names.
		  •	 A function name must be followed by opening and closing parenthesis.
		  •	 Arguments should be enclosed in the parenthesis.
	 5.	 Worksheets in Excel have names like Sheet 1, Sheet 2 and so on. But these names can be 

changed to other names which more descriptive. Follow these steps to rename a worksheet.
		  •	 Right-click on the Sheet 1 tab in the worksheet.
		  •	 Click on the Rename option from the ‘Shortcut’ menu that will appear.
		  •	 The cursor will appear in the ‘Sheet 1’ tab. Rename it and press the Enter key.



Chapter 3 : Charts in Excel 2016
A.	 Fill in the blanks.
	 1.	 A _________ helps us to compare and analyse data.
	 2.	 A chart has the following components: ________, Y axis, _____________, axis title, 

___________, plot area, legend, _____________ and data labels.
	 3.	 ____________ describes the content of the chart.
	 4.	 The chart tools are located on ___________ and ___________ tabs.
	 5.	 Move Chart button in the Location group of the _______________.

B.	 State whether the following statements are True or False. 
	 1.	 Select the cell and press the F10 key. Excel automatically creates a chart for you.
	 2.	 To make a chart, we first need to enter the data into a worksheet.
	 3.	 Bubble chart is specially designed for plotting data values related to trades and shares.
	 4.	 A radar chart looks like a spider’s web.
	 5.	 Pie chart is used for comparing multiple values through horizontal and vertical bars.

C.	 Match the columns.
			   Column A		  Column B
	 1.	 Chart	 (a)	 Area within which all the chart components are found
	 2.	 Chart area	 (b)	 Axes (X, Y) of a graph
	 3.	 Coordinates	 (c)	 A pictorial representation of data
	 4.	 Data series	 (d)	 Lines running from X and Y axes separately
	 5.	 Gridlines	 (e)	 A collection of entries from which a chart is derived

D.	 Label the components of the given window.

E.	 Answer the following questions.
	 1.	 Name the types of charts in Excel.
	 2.	 Write a note on Bar Chart.
	 3.	 Write the steps to insert a chart title.
	 4.	 Write the steps to print a chart.
	 5.	 Write the steps to format the legend.



Answers to Worksheet

A.	 1.	 chart
	 2.	 X axis, chart title, chart area, gridlines
	 3.	 Chart title
	 4.	 Design, Format
	 5.	 Design tab
B.	 1.	 False 	 2.	 True 	 3.	 False
	 4.	 True	 5.	 False
C.	 1.	 (c)	 2.	 (a)	 3.	 (b)
	 4.	 (d)	 5.	 (e)
D.	 1.	

E.	 1.	 Some of the most commonly used charts are as follows.
		  •	 Column chart			  •	 Line chart
		  •	 Pie chart			   •	 Bar chart
		  •	 Area chart			   •	 XY Scatter chart
		  •	 Radar chart			   •	 Stock chart
		  •	 Doughnut chart	 •	 Bubble chart
	 2.	 A bar chart shows comparison among individual items through a cluster of bars. Categories 

are organised vertically and values horizontally in the bar charts. It is very similar to a column 
chart. A bar chart can be described as a column chart drawn sideways. It is used for comparing 
multiple values through horizontal and vertical bars.

Y axis

Data series

Legend

X axis

Plot area

Gridlines



	 3.	 Follow these steps to insert a chart title.
		  •	 Click on the Design tab.
		  •	 Click on the Add Chart Element in the ‘Chart Layouts’ group.
		  •	 A list of options will appear. Select the Chart Title option.
		  •	 Select either the Above Chart or Centered Overlay option.
		  •	 A ‘Chart Title’ text box will appear. Type the text in it. The title will be added as you click 

outside the chart.
	 4.	 Follow these steps to print a chart.
		  •	 Select the chart and click on the File tab.
		  •	 Select the Print option.
		  •	 Click on the Print button.
	 5.	 Follow these steps to format the legend.
		  •	 Right-click on the legend boundary and select the Format Legend option. 
		  •	 The ‘Format Legend’ task pane will appear on the right side. Click on the Fill & Line tab and 

select the Border option and change the width by clicking on the spin arrows.
		  •	 Select the desired colour by clicking on the Color drop-down arrow.
		  •	 Click on the Close button.



Chapter 4 : Algorithms and Flowcharts

A.	 Fill in the blanks.
	 1.	 An _____________ is a step-by-step instruction written in simple English language to perform 

a particular task.
	 2.	 A _______________ is a pictorial representation of steps of an algorithm used for solving a 

particular problem.
	 3.	 A _________________ is used to indicate the acceptance of inputs from a user or the output 

concluded.
	 4.	 A _______________ represents steps involving decision to be taken on the basis of a specific 

condition.
	 5.	 ____________ is the process of following one or two or more alternate paths of computation.

B.	 State whether the following statements are True or False. 
	 1.	 Writing a program involves just one step.
	 2.	 An algorithm should be well-ordered, clear and effectively computable.
	 3.	 A computer can only understand the instructions given in machine language.
	 4.	 A flowchart is a graphical representation of a program which uses some basic symbols.
	 5.	 After writing the algorithm, a flowchart is drawn which is converted into a program.

C.	 Match the columns.
			   Column A		  Column B

		 1.	 	 (a)	 Process

		 2.	 	 (b)	 Start/Stop

	 3.	 	 (c)	 Decision Box

	 4.	 	 (d)	 Arrows

	 5.	 	 (e)	 Input / Output

D.	 Answer the following questions.
	 1.	 What are the advantages of writing algorithm?
	 2.	 Write the rules for writing algorithms.
	 3.	 What are the features of a good algorithm?
	 4.	 What are the advantages and disadvantages of flowcharts?
	 5.	 What are the rules for drawing a flowchart?



Answers to Worksheet

A.	 1.	 algorithm	 2.	 flowchart	 3.	 parallelogram
	 4.	 diamond	 5.	 Branching
B.	 1.	 False 	 2.	 True 	 3.	 True	 4.	 True	 5.	 True
C.	 1.	 (b)	 2.	 (e)	 3.	 (d)	 4.	 (a)	 5.	 (c)
D.	 1.	 There are many advantages of writing algorithms. Some of them are as follows.
		  •	 Algorithms are easy to understand, implement and modify.
		  •	 Algorithms are independent of any computer language.
		  •	 Algorithms can be easily converted into flowcharts and then into computer programs.
	 2.	 There are certain rules that we need to follow while writing an algorithm. Follow the given 

rules to write algorithms.
		  •	 Algorithm must begin with the word ‘Start’.
		  •	 Number the statements such as Step 1, Step 2 and so on.
		  •	 Write the statements clearly.
		  •	 Each statement must be written in a separate line.
		  •	 Each step should be clear and precise.
		  •	 Algorithm must end with the word ‘Stop’.
	 3.	 A good algorithm should possess the following features.
		  •	 Input: An algorithm must have an input.
		  •	 Definiteness: Each step of an algorithm must be written in a simple and precise manner so 

that it is easy to understand.
		  •	 Uniqueness: There should be no repetition of steps.
		  •	 Finiteness: Each algorithm should include finite number of steps.
		  •	 Output: After all the steps are executed, the algorithm should provide the desired result.
	 4.	 Following are the advantages of flowcharts.
		  •	 Communication: Flowcharts are a better way of communicating the logic of a system.
		  •	 Effective Analysis: Problem can be analysed in a more effective way using the flowchart.
		  •	 Proper Documentation: Flowcharts serve as good program documentation.
		  •	 Efficient Coding: Flowcharts act as guides or blueprints during the system analysis and 

program development phase.
		  Following are the disadvantages of flowcharts.
		  •	 Flowcharts become complex if the program logic is complicated.
		  •	 If any modification is to be made, then the flowchart has to be completely redrawn.
		  •	 Flowcharts are only theoretical tools for understanding a program.
	 5.	 Follow these rules to draw a flowchart.
		  •	 The direction of flowchart is either from top to bottom or from left to right.
		  •	 There should be one Start box and one Stop box.
		  •	 Arrow head indicates the flow of data.
		  •	 A connector is used to connect breaks in the flowchart. It is also used to join one page to 

another.


